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ان یکی از نرم افزارهایی است که با کمک آن می تو EndNoteنرم افزار •
.  منابع را مدیریت کرده و در متن ارجاع دهی نمود

نامه  با استفاده از این نرم افزار می توان منابع موجود در مقالات و پایان•
دانشکده خود و یا ژورنال های داخلی و ها را بر اساس سبک نگارشی

.پژوهشی و کنفرانس ها انطباق داد –خارجی، مجلات علمی 



EndNoteاصطلاحات رایج در 

 ، که به منابع استناد شده در متن مقاله گفتهCitationمستندات يا •
.مي شود

ر ، که در پايان متن پژوهشي يا مقاله ذکBibliographyفهرست منابع يا •
.مي شود

اده ، که مجلات مختلف براي نوشتن منابع از آنها استفStyleسبک يا •
.مي کنند
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ENDNOTاستفاده از نرم افزار  نید چنانچه برای اولین بار از این برنامه استفاده می ک•
.شما نمایش داده می شود برایپنجره مقابل 

  جدید Libraryبا انتخاب گزینه دوم می توانید یک •
.بسازید

•Library را همچنین می توان از طریق مسیر  جدیدFile 
> New…  ایجاد کرد.

 قبلی، گزینه سوم را انتخاب Libraryدر صورت داشتن •
.کنید
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Libraryروش های ورود منابع به یک 
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تايپ دستي بخش هاي منابع: روش اول•
ه در پنجره بازشده بر روی علامت اضاف•

ده کردن منبع که در شکل نشان داده ش
.است کلیک نمایید

  هایگزینههمچنین می توانید با انتخاب •
References > New reference  از

د نوار منوی بالای صفحه وارد صفحه ورو
دستی منابع شوید 
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20
.، اولین کلمه نام خانوادگی استکامادر صورت وجود  **25

.، آخرین کلمه نام خانوادگی استکامادر صورت عدم وجود 



روش های ورود منابع به برنامه
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سال انتشار 6

EndNoteبرنامه  طريقمنابع از  مستقيموارد کردن : روش دوم•

، آنلاینو  آفلایناز حالت  ترکیبیاول  گزینه: می شودمشاهده  گزینهسه  EndNoteدر گوشه سمت چپ پنجره •
دا بر روی اینترنت ابت طریقوارد کردن منابع از  برای. است آنلاینسوم حالت  گزینهو  آفلایندوم حالت  گزینه

.کلیک کنید Online Searchآنلاین و سپس بر روی یکی از گزینه های  آیکون
.هستند رایگاناست  PubMed (NLM)آنها  مهمترینها که  پایگاه ایناز  برخیمقالات •
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روش های ورود منابع به برنامه
.  اییدبرای وارد کردن منابع از این طریق باید قسمت های مورد نیاز پنجره نشان داده در شکل زیر را تکمیل نم•

این . ماییدمی توانید فقط کلمات کلیدی را وارد کرده و اقدام به جستجو ن. پرکردن تمام فیلدها مورد نیاز نیست
.داردقرار  پایینبرنامه در  5و  4پنجره در نسخه های 
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ده انتخاب مد نظر را از بین موارد یافته ش رفرنسهایبعد از انجام جستجو لازم، لازم است : نکته
آنها را به کتابخانه مورد  References > Copy references toکرده و پس از رفتن به مسیر 

.  نظر اضافه کنید
.مشخص شده در بالا کلیک کنید آیکونبرای این کار همچنین میتوانید بر روی 



روش های ورود منابع به برنامه
و يا ساير سايت  Google Scholar ،PubMedوارد کردن منابع به صورت مستقيم از طريق : روش سوم•

 Googleعبارت  googleابتدا در . وجود دارد اندنوتاست که امکان انتقال نتايج جستجو از آنها به  هايي
Scholar   کرده و وارد بخش  سرچراGoogle Scholar شويد.
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:نکته•
 ، مرور و ويرايش آنها ضروري است تا ايرادات احتمالي موجود در آنها اصلاحاندنوتبعد از ذخيره منابع در 

ا حرف يا ممکن است همه کلمات يک عنوان ب اندنشده  ايتاليکزيرا گاهي بعضي لغات علمي در عنوان . شود
.بزرگ شروع شده باشند و يا ايرادات ديگري وجود داشته باشد



ا را مکان نم. نمایید، ابتدا باید مقاله یا پابان نامه نوشته شده خود را باز Wordبرای وارد کردن منابع به •
.درجایی قرار دهید که منبع باید ذکر شود، مثلا در پایان جمله یا پاراگراف
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Wordبه  EndNoteنحوه ورود منابع از طریق 
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 منبع یا منابع مورد نظر را•
ه انتخاب نمایید و سپس ب

.برگردید Wordبرنامه 
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Wordبه  EndNoteنحوه ورود منابع از طریق 
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Ctrl + Click for 
multiple citation
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، سبک های مختلفی وجود دارند که Styleدر قسمت •
اب متناسب با مجله و یا پایان نامه خود باید آنها را انتخ

هم  EndNoteالبته این کار را در داخل برنامه . نمایید
ر را در می توانید انجام دهید ولی تا زمانی که سبک مورد نظ

Word انتخاب نکنید، تغییرات اعمال نخواهند شد
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به  wordنرمال را در  استایل، به صورت چپ چین اضافه شود، باید از همان ابتدا Wordاینکه منابع در  برای•
پاراگراف امکان پذیر است تنظیماتاین کار در . تعریف کنید Left to Rightصورت 
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Wordبه  EndNoteنحوه ورود منابع از طریق 
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حذف نویسنده یا سال در یک ارجاع
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ی این برا. همانگونه که در مثال زیر مشاهده می شود، گاهی لازم است نام نویسنده یا سال در داخل متن حذف شود•
. مراجعه کرد Wordدر  …EndNote X6 > Edit & Manage Citation(s)منظور می توان به مسیر 
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Wordبه  EndNoteنحوه ورود منابع از طریق 
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ه را در جدید در متن لیست منابع به روز شود، گزینه مربوط رفرنسخواهید هر بار پس از اضافه کردن  نمیاگر •
.خاموش کنید Endnote X6 > Bibliography > Instant formatingمسیر 
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 < Endnote X6در پنجره •
Bibliography  چون  مواردیهمچنین

ها را  رفرنسفاصله و میزان تو رفتگی 
.تعریف کردمی توان  Layoutقسمت 
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سیر مشکل داشت، به م کالنسمیسال، اگر ارجاعات به صورت زیر در آخرین -اسم فورمتدر صورت استفاده از 
Endnote > Bibliography  رفته و تیک مربوط به لینک را در تبFormat Bibliography بردارید.



ENDNOTاستفاده از نرم افزار 
خود را انتخاب نموده و  Libraryبعد از انتخاب گزینه دوم، در پنجره بازشده، نام و محل ذخیره شدن •

.کلیک کنید SAVEبر روی دکمه 
واقع در نوار ابزار بالای برنامه  File/ Newجدید از منوی  Libraryشما همچنین می توانید برای ایجاد •

EndNote  نماییدهم استفاده.
  … File > Compressed library (.enlx)فشرده و ایمیل آن از مسیر   Libraryبرای ذخیره یک •

استفاده کنید
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:EndNoteفایل معمولی  :EndNoteفایل فشرده 

Library. enlx

Library.enl

1 2

3
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Styleایجاد یا ویرایش 

يره براي تغيير مسير ذخ
و فيلترها استايلها

 Edit > Preferences
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Styleایجاد یا ویرایش 
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Styleایجاد یا ویرایش 
ت موجود که با سبک مورد نظر بیشترین مطابق هایStyleاز  یکیبهتر است  استایلیک  ایجاربرای 

برای پیدا کردن اسلاید مورد نظر می توانید به مسیر. کنید ویرایشرا دارد را انتخاب و 
  Help > Web Styles Finder … در برنامه رفته یا به آدرس زیر مراجعه کنید.

http://www.endnote.com/support/enstyles.asp ه، 
مع

ج
02 

ه 
م

20
25

http://www.endnote.com/support/enstyles.asp
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Styleایجاد یا ویرایش 
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Styleایجاد یا ویرایش 
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شماره 
(superscripted 

Number)

-Non)شماره 

superscripted 
Number)
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-Author)اسم و سال 
Year )
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Ambiguous citations: two references with the same author and year

(Miller 2000a, b)

(Miller 2000a, 2000b)

or

Example:
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Author Lists: to control how many author names will appear in the citation
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Author Name: how the authors’ names will appear 
within the formatted citation
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Numbering: If you are using a numbered style you can set options for 
how number ranges will be handled here.
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Sort order: If more than one reference is cited together in the text, 
how their order should be. 
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Bibliography section

- Some options are controlled from the Format 
Bibliography command in Word, such as line and 
indentation spacing.
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Templates
The bibliography template is the heart of the style.  Here 
you can set the fields and their order which will be included 
for each reference type

examples of the reference types:

Journal Article: Grayhame, G. (1978). Territorial behaviour of male noble dragonets (Draconis
noblis). Journal of the Draconic Guild of the Realm of Faerie 58, 731-734.

Book Section: Magnus, A. G. (1959). The nature and physiology of the pituitary hormones of 
dragons. In The endocrine system in dragons (Faust, E., editor), pp. 404-422. Amber: Unicorn 
Press.

Electronic Article: Ambrosius, M., et al. (1023). Nesting behavior of the northern ice dragon. 
Dragon Behavior. doi: 10.002/db.1022.003.

These give us the information we need to create templates for a book section, a journal article, 
and an online electronic article, as seen below.
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Special Character Properties of Special Character
End of Paragraph
( ¶ : the paragraph mark)

This will insert a line break.

Tab
( → : the tab arrow)

This will insert a tab.

Singular/Plural
( ^ : the caret)

Example: in the Book Section template above, “p.^pp.” indicates that if there is only one 
page number, then “p.” should be used but if there is more than one page number, then 
“pp.” is used.

Field Name Indicator
( ` : the accent grave)

Example: In the Book Section example above, the word “editor” is also the name of an 
EndNote field.  If it were entered without the accents surrounding it, EndNote would 
insert the contents of the Editor field instead of the text.

Link Adjacent Text
(  : the small diamond)

This is usually used in place of a normal space. In the above example, the “p.” or “pp.” and 
their preceding comma should be present only if there is data in the Pages field.  The 
character  between the comma and “p.^pp.” links the comma to the singular/plural text 
string; it also links the “p.^pp.” text string to the Pages field following it.  If there is nothing 
in the Pages field, the comma and the “p.^pp.” will not appear in the bibliography.

Forced Separation
( | : the vertical line)

In the above example, If there was no data in the City field, the colon would not appear.  
However, we want it to appear whenever there is data in the Publisher field, whether or 
not there is data in the City field.  To accomplish this we put a Forced Separation between 
the City field and the colon, then use Link Adjacent Text to link the colon to the Publisher 
field.

Book
Author: Title. Book Title|.`Edited by`Editor.Editioned|.City|:Publisher|,Year|,p.^pp.Pages|.
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Author list: If more than one reference is cited together in the text, 
how their order should be. 
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Author Name:
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Layout: To add special extra fields, punctuation, or text to the 
beginning or end of every reference. 
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Some journals requires author mark references "of 
special interest.

EndNote is not designed to insert author mark 

automatically.  The user will have to edit the 
citations and bibliography after formatting to add 
bullets. ه، 

مع
ج

02 
ه 

م
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، این wordهای مورد نظر اضافه کرده و سپس برای اینکه در   رفرنسبه  Notesبا این وجود می توان توضیحات مربوطه را در قسمت 
.زیر را انجام داد تنظیماتمربوطه اضافه شوند،  رفرنستوضیحات در زیر 
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Sort Order: options control how references in the 
bibliography will be sorted.
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Title Capitalization: EndNote can change the capitalization of 
the title used in the reference.
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The footnote settings control how any reference that 
is inserted into a footnote will be formatted.
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The footnote settings control how any reference that 
is inserted into a footnote will be formatted.
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Space below tables and figures and whether or not to place a period after labels and 
captions.
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Space below tables and figures and whether or not to place a period after labels and 
captions.
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Setting Caption Options for Figures and Tables in Word

To open the caption numbering 
options in Word select 
Reference>Caption from Word’s 
Insert menu as shown below.
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CDمحتویات 

1
EndNoteافزار نرم •

2 بهینه شده استایلچند •

3
فایل های آموزشی•

Web: http://www.endnote.com/
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